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Traditional 911 Services
not available from VOIPs
The Texas attorney general filed a
lawsuit against Internet telephone
service Vonage, saying the company
fails to clearly tell consumers about
the limits of 911 emergency calling
over its service. The suit stems from a
incident last month in Houston where
a husband and wife were shot by
burglars while their daughter tried to
call 911 on a Vonage line and reached
a recording. Independent VOIP
providers typically do not have
access to the traditional 911 system
which carries calls to emergency
dispatchers and transmits data about
the caller’s location. As a
work-around, Vonage tells customers
they need to activate a 911 service,
but that service directs calls to
Continued on page 3

Cobra
http://www.cobra.com

Autocom
http://www.autocomonline.com
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Their EZPlayer can play DVD,
MP3, audio CDs, do wireless
Internet, and give navigation with
turn by turn voice guidance. It has a
7”-8” touch screen for display.

Castle Tek
http://www.castletek.com

More than just a GPS navigation
unit it has a 80GB hard drive with
512MB of RAM. You can play
MP3’s, DVD movies, wireless

Internet, XM radio, web camera and,
yes, serve as a GPS. Installed by their
own networking engineers it can
provide HVAC control for lighting,
camera monitoring, or any device
you wish to control. Security tie-ins,
remote monitoring, and automated
backup systems. Controlled using a
wireless touchpad, a wall-mounted
touch screen, or through the
computer.

GPS 500 comes programmed with
continental U.S. state boundaries,
Canadian political boundaries and
European country boundaries. With
optional computer software and
interface
cable, the user
can exchange
data with
computer
mapping
programs.
Also optional
is POI (points
of interest) to
use in
navigation or
as map
references.
The user can
choose from 18 position formats to
display the location coordinates.
Choice of display fields position or
navigation include: Accuracy,
Average Speed, Bearing, Date,
Destination, Elevation, ETA,
Location, Maximum Speed,
Odometer, Power, Speed, Time, Trip
Odometer, and Trip Time. Store up to
500 waypoints with names and
symbols. Create up to 20 routes with
up to 50 points (waypoints and/or
Continued on page 4
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administrative telephone lines that in
some cases are unanswered.

MRI in a Pill
A South Korean semiconductor
manufacturer has announced an
image sensor for pill-size cameras
that doctors can use to obtain
accurate information about a patient’s
digestive tract. The image sensor can
take up to 50,000 photographs in an
eight-hour tour of the patient’s
insides by taking two pictures a
second. Mass production will begin
in the second half of 2005.

Mouse Adaptor for Shaky
Hands
IBM has developed an adjustable
mouse adapter that compensates for
the shakes of patients with hand
tumors and other causes of
uncontrollable shaking. According to
the International Essential Tremor
Foundation, in the US alone nearly
10 million people are affected by
essential tremor, the most common
form of hand tremors. This adapter
will plug in between the mouse and
computer and is compatible with
existing mice.

Cell Phone Helmets for
Bikers
Motorcyclists are now able to talk
and ride by using a mobile-phone
headset for crash helmets,
demonstrated at the CeBit trade show.
The headsets (full-face, open-face
and flip-up), have audio capabilities
at speeds up to 62 miles per hour.

Now You CAN Return
Unwrapped Software
In the settlement of a California
lawsuit Microsoft, Symantec, Adobe
and others have agreed to publish

EULA agreements on their websites
for their respective products, while
CompUSA, Best Buy, and Staples
agreed to allow consumers to return
unwrapped software for full monetary
refunds, even if the shrink-wrap has
been opened. Details of the
settlement can be found at:
http://www.techfirm.com/AmendedComplaint-Filed.
pdf

Great New Escape
Virtual reality, technology that
gives users the feeling they are
somewhere else, can be of great value
in treating people suffering from a
variety of physical or psychological
conditions. Therapy based on the
technology is being used in a small
number of U.S. clinics to treat burn
victims and people with phobias such
as the fear of flying, spiders, and
heights. Researchers say the
technology holds enormous promise
for treating PTSD, addictions and for
use as a distraction technique in
painful dental and medical
procedures, including chemotherapy
and physical therapy.

Creative Commons
Rewrites Copyright!
When Chuck D and the Fine Arts
Militia released their latest single,
“No Meaning No,” They encouraged
everyone to view, copy, mix, remix,
sample, imitate, parody and even
criticize it under a new licensing
scheme called Creative Commons
that some say may be better suited to
the electronic age than the
controversial copyright license. More
than 10 million other
creations—ranging from the movie
“Outfoxed” and songs by the Beastie
Boys to the BBC’s news footage and
the tech support books—have been
distributed using Creative Commons
licenses, which allow artists to keep
“some rights reserved” rather than

“all rights reserved”. Online users can
go to
http:// www.CreativeCommons.org

and search its archives.

WinFS to be included in
WinXP Update
Microsoft has said it plans to add
support for WinFS to Windows XP.
The operating system will support all
three key Longhorn components
WinFS, Avalon, and Indigo. Win FS
is built on top of the fundamentals,
which would include security
features and technology to make sure
applications and drivers don’t
conflict. A first beta of Longhorn is
set to ship by the end of June.
Microsoft plans to have a beta test
version of WinFS available when
Longhorn ships, probably late next
year, and add it as an update to
WinXP later. Microsoft is expected to
handout a pre-beta preview release at
the Microsoft Win HEC Conference.

New Photoshop CS Details
Adobe is still finding its bearings
after it unintentionally released
details of its next Photoshop upgrade.
The company quickly pulled down
the announcement, but Google never
forgets. Check out Publish.com’s
rundown of the new features:
http://ct.eletters.whatsnewnow.com/rd/cts?d=181-4
31-1-278-41858-19872-0-0-0-1

_______
There is no restriction against any
non-profit group using this article as
long as it is kept in context with
proper credit given the author. The
Editorial Committee of the
Association of Personal Computer
User Groups (APCUG), an
international organization of which
this group is a member, brings this
article to you.
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POI). It can automatically track your
travel with up to 2,000 log points.

Dual Electronics
http://www.dualav.com

Just released is the first two
editions of its NavAtlas™ vehicle
navigation lineup. The XNAV9525
mobile navigation system (SRP:
$1,199) features a 20GB hard-drive

mapping software. However, in lieu
of an internal hard disk drive it will
store all information on a 1GB
Compact Flash storage card that will
be upgraded as new software is
introduced. (The system will play
MP3 and AVI files stored on
Compact Flash cards as well.) A
backup DVD with all mapping
software will be included at no extra
charge.

The iQue M5 uses a Pocket PC
supporting portrait/landscape screen
orientation for easy viewing of
documents, videos, and web
content. The embedded Bluetooth®
transceiver allows the user to
establish a personal-area network
with computer systems and
Bluetooth-enabled devices such as
mobile phones, other PDAs, and

Garmin
http://www.garmin.com

preloaded with Tele Atlas™ digital
maps for the entire continental U.S.
as well as Canada, including
approximately two million points of
interest. It runs on the Windows®
CE.Net™ operating system, using a
32-Bit processor to run the
12-channel receiver. The hard drive
offers easy access to information, at
faster rates than with conventional
disc-based software. As revised
maps and software are introduced,
users can update it via a USB or
LAN connection. There are
turn-by-turn instructions with
natural voice guidance, distance
information, high speed auto
re-routing, and even a driving
simulation analysis. All key
functions are accessible via a remote
control (included).
In addition to saving the mapping
software, the hard drive is
partitioned so that 10GB may be
used to store and access MP3 audio
files through the vehicle’s audio
system. End-users can enjoy up to
approximately 5,000 songs that can
be stored.
In the Q2 of 2005, the
NAV3500P (SRP: $999) will be a
portable system that can be used as
either a handheld, or in-car unit.
Similarly it will feature pre-loaded
Page 4

It comes pre-loaded with highly
detailed MapSource City Select
street data. The StreetPilot c330
database features five million-plus
points of interest—including hotels,
restaurants, gas stations, ATMs, and
attractions throughout the U.S.,
Canada, and Puerto Rico. It features
a simple touch screen interface, with
automatic route calculation to any
destination and turn-by-turn,
voice-prompted directions along the
way. Selecting a destination requires
only a limited amount of input from
the user. Plus it allows you to
choose between a three-dimensional
navigation view or the more
traditional “bird’s eye” overhead
view. There are dual integrated
speakers for high-quality voice
prompts, and an internal lithium-ion
battery for out-of-car route use. A
detour function enables routing
around traffic problems or road
construction; custom road
preference allows user to prioritize
choice of back roads or major
highways; automatic off route recalc
shows how to get back on track if
you miss a turn or exit. The SRP is
$964.

printers. It features built-in basemap
of North and South America and
Puerto Rico showing major
highways, thoroughfares, railways,
lakes, rivers, and borders.
MapSource City Select CD-ROM is
a standard accessory, so users can
download detailed street-level map
data. It has the same POI, routing,
and detour functions as the c330.
The user can attach a “location
stamp” to a profile in the user’s
contact database or appointment
calendar and navigate directly to
these addresses. The SRP is $750.

Gizmondo
http://www.gizmondo.com
gizmondo@IndigoPearl.com

This is a
multi-use unit,
mainly as a
gaming console.
It has 64MB of
RAM with a SD
card slot for
primary storage.
Out of the box
the GPS will
create a basic
map of the
terrain and

display where you are. You can
purchase detailed street maps loading
in the SD slot. There is a panic button
which when pressed it will signal to
numbers (people) you have stored
where you are.

Lowrance
http://www.lowrance.com

Introduced was the iFINDER
Map&Music and iFINDER PhD.
Both have a 3" screen with 16-level
gray scale definition, and background
map which details metro areas, major
roadways, and a exit services
database. There are SD slots for those
that may want to purchase extra maps
such as Fishing Hot Spots, or
NauticPath. With the SD slot they
offer MP3 support and include
headphones for listening. With the
Plus units MapCreate is also included
to create elevation contour lines, and
marine detail of coastal waters. On
the MapCreate CD is a database of 2
million POI. The PhD unit features

the motorist back on course. It has a
20GB hard drive with 10GB
pre-loaded with detailed mapping.
The mapping has the U.S. and
Canada, and includes information
such as one-way streets, POI, and
more. The other 10GB is for digital
music storage. It connects to any PC
via the USB for downloading songs
to it. In the music mode the touch
screen control everything. While
driving to a location it will interrupt
the music momentarily to give
audible directional commands.

Lightweight and portable, the it can
be easily transferred from car to car.
There are over 2 million points of
interest in over 40 categories built-in.

Magellan

Search by name or category for gas
stations, restaurants, hotels, ATMs,
sights, amusements and more.

http://www.magellangps.com/en

The Magellan eXplorist 500 has a
16-color display with a USB data
port and data storage via secure
digital (SD) card. You can add
detailed street maps, topo or lake

You can select your route by the:
Shortest Time, Shortest Distance,
Least or Most Use of Freeways. Store
up to 100 personal or business
destinations per user for a total of 300
addresses. Each user can even
personally select their top three
destinations to keep them handy.
Screen views include:

• True View – shows a detailed

an electronic compass, and a
barometric altimeter with weather
predictions. Prices start at $259 for
the Map&Music model.
The iWAY™ 500c has a 5" 256
color TFT display with adjustable
backlighting. It shows the way and
provides voice turn-by-turn
directions. If a turn is missed it
automatically replots the route to get

maps from optional Magellan
MapSend software. There is 8MB of
built-in maps allowing the user to
save 5 track log files, 20 routes and
500 points of interest. The user can
store as many as they want on
optional SD cards. The Li-Ion
rechargeable battery pack can keep it
continuously powered-up for up to 14
hours.
RoadMate 700 is built on the same
technologies as the Hertz
NeverLost® system. It comes with a
built-in map database of the entire
U.S. and Canada. Turn-by-turn
guidance with TrueView™ 3D
navigation and voice prompting
indicates when to make your next
turn. Accurately is within 3 meters.

view of actual road layout for
upcoming turns and information
about intersection maneuvers.
• Map View – bold and easy-to
read icons and text.
• Maneuver List – details when
and where to expect turns along
the route.
• Route Exclusion – Want to avoid
a certain road or maneuver? Simply press a button and it will find
another route.

Mobile Crossing
http://www.mobilecrossing.com

Their new WayPoint navigation
systems feature driver-centric
capabilities such as one-touch feature
access, traffic and weather while
doubling as a Microsoft Windows
Mobile 2003 Pocket PC. It features
built-in Navteq maps, navigation
software based around a customized
version of the Mapopolis routing
engine. With it is: spoken directions,
full color moving maps, touch screen,
personal landmarks, toll road avoider
and built-in POI. Available in two
versions the entry-level WayPoint
Page 5

Mio
http://www.miogps.com

With the Mio 168RS you’re
getting a Pocket PC with a Intel®
Xscale 300 MHz. The GPS will give
you voice and visual turn by turn
guidance to your destination. You
can plan trips with multiple stopping
feature. There are millions of POI
including lodging, restaurants, and
gas stations. You can make an

100 and the Bluetooth-enabled

slot. The iCN 650 has a 2.0GB hard
drive with all the street level maps
of the U.S. and Canada installed.
Guidance for Back-on-Track™ is
included if you have to go off the
planned route. Points of interest and
multiple stop route planning is
included. You can create your own
POI with their SmartST™ Desktop
Editor on your computer. All have
TFT color screens with the 510
having a 3.5” while the 635 and 650
have 3.8”. The Maps are in 3D, and
the user has a choice of night or day
screen for traveling conditions. You
can enter your favorites such as
home, office, restaurant, or put in an
area to avoid.

Pioneer

WayPoint 200. The 200 is capable
of connecting to the internet on the
road via available Bluetooth cellular
phones. Once connected, the device
displays real-time weather and
traffic. It uses a 400Mhz Intel
Xscale CPU, and has 224Mb total
memory, with CompactFlash and
Secure Digital / MMC slots. The
weather is provided by Weather
Underground, Inc. by referencing
live radar and satellite imagery
superimposed on GPS centered
maps. Users receive weather data
that moves as they do and keeps
them aware of the very latest in
local storm and weather conditions.
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address and/or telephone number as
a POI. The user can program them
in for a trip, make favorites, or
create a history. It will suggest an
alternate route if you take a wrong
turn. There are detailed street maps
of U.S. and Canada. It is a full
featured PocketPC— Pocket
Outlook, Word, Excel, Media Player
and Internet Explorer is included.
All software, maps and accessories
are included in the package.
Mio168RS can hold all of your
contacts, appointments and
important files. It’s portable and can
be used in any car, or walking
through cities.

Navman
http://www.navmanusa.com

They have three models to choose
from. All of them will draw power
from car battery or AC in the home.
All will give turn by turn
instructions. With both the iCN 510
and iCN 635 you buy plug-in maps
which you put into the SD/MMC

http://www.pioneer-usa.com

Their new AVIC-N2 and
AVIC-D1 can receive XM
NavTraffic service to provide
drivers with detailed traffic
information, and provide alternative
routes. With the subscription
service, the systems graphically
communicate traffic incidents and
road flow conditions using traffic
icons overlaid on the map to quickly
identify road events relative to the
vehicle’s location. Both navigation
systems feature dynamic route
guidance that suggest alternate
routes around major traffic incidents
and heavily congested roads. It is a
subscription service of XM
NavTraffic and XM Satellite Radio.
The service provides in-depth traffic
data for 20 major metropolitan cities
across the nation, covering
cumulatively 50 percent of the
population in the U.S. The
subscription pricing will be $14 a
month for a bundled offering of XM
NavTraffic and XM Radio.

Sanyo

Transplant GPS

Wherify

http://www.sanyo.com

http://www.transplantcomputing.com

http://www.wherify.com

Expected available in the second
quarter of 2005 the NV-E7500 is an
update for their EV7000. For $1,500
you’ll get a DVD-based
GPS-navigation and
multimedia-entertainment system. A
7-inch widescreen TFT monitor with
touch screen ability is the focal point
of this sophisticated portable
navigation system that can double as
a DVD movie and CD/CD-R/CR-RW
music player. It can easily be moved
between vehicles or used virtually
anywhere, indoors or out. Comes
with a built-in speaker, wireless

The EMTAC Bluetooth GPS III
allows you to receive GPS data
wirelessly and continuously for
twenty (20) hours on only four (4)
AAA Alkaline Batteries. It does
require a Bluetooth enabled PDA or
Laptop (built-in or add-on.) The
Transplant CF Primum GPS receiver
is a Global Positioning Receiver with
a type II CompactFlash interface.
Compatible devices include all
Pocket PCs with a CompactFlash
slot, Win CE devices, and Laptop
computers (using a PC Card
Adapter).

Whether at work, home or
traveling, simply use the Internet or
any phone to quickly identify the
location of the device within feet in
about a minute. The Wherify
Wherifone G550® Locator Phone
also contains a two-way
speakerphone as an added feature to
stay in touch. In addition to the
ability to locate or make incoming
and outgoing calls, the GPS Locator
Phone gives a child or adult carrying
it a new level of security knowing
they can also request a 911
emergency response at the touch of a
button. It has five programmable
buttons for one-touch dialing.

remote control, two sets of wireless
headphones, and vehicle mounting
bracket. Its DVD entertainment mode
is Dolby Digital and DTS ready.
On the GPS side, Sanyo includes a
DVD loaded with maps of North
America and voice-guided directions.
The system comes with a DVD map
disc covering the entire Continental
U.S. and Canada. Voice Guidance
and built-in stereo speakers provide
hands-free safety along the selected
route. Search by phone, address, or
points of interest.
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Go ahead and nest:
Customizing Office
Help
Applies to: PowerPoint,
Word, Excel
By The Crabby Office Lady

W

hether you’re conventional
or conceptual, straight-laced or silly,
you can make Office look and work
the way you want it to. Let’s
customize Microsoft Office toolbars
and buttons to suit your way of
working and your delicate
sensibilities.
Before I jump into this, I have a
question. When you go on a trip and
you arrive at your hotel, which of
the following scenarios best
describes what you do?
a. Throw your suitcase on the bed,
splash some water on your face,
and head out the door to explore
the area.
b. Throw your suitcase on the bed,
change your clothes, check out the
minibar, splash some water on
your face, and head out the door
to explore the area.
c. Throw your suitcase on the bed,
open the drapes, and unpack, unfold, and put away every item.
Prop up some framed photos, see
what’s in the mini-bar, check out
the cable guide, review the fire
evacuation plan, pocket all the
free little lotion and shampoo bottles right away, and note the
checkout time in your Pocket PC.
Take a long hot bath, have a
snooze, brush, floss, splash cold
water on your face, and head out
the door to explore the area.
d. Forget the hotel—I’m happy in a
tent on the outskirts of the city!
Page 8

If you said A, settle down,
Cha-Cha, the world can wait. The
hotel room is part of the trip.
If you said B, you’re on the right
track—you know how to stop and
smell the roses.
If you chose C, you’re
experiencing nesting overload.
(Stick with me; I can help.)
And D? I’d like to see you and C
on a honeymoon together. What a
great tale to tell your kids.
So what does this scenario have
to do with customizing your Office
products? Simple: It shows how
comfortable you like to get with
your surroundings. Are you happy
with the standard toolbar, the
buttons all lined up like little
soldiers, just taking things as they
come? Or are you more inclined to
add personal touches and make the
place feel like home immediately?

for me to pick up your bags, take
you up the elevator, hold my hand
out for a tip, and open the blinds for
you so you can see the view. Ready?
Let’s check in and see what this
software suite offers in the way of
amenities.
There are lots of little things you
can do to make your Office window
friendlier and easier to use. I mean,
some of you spend an awful lot of
time fiddling with menus, buttons,
and toolbars. The instructions below
work for any Office program.

Menus and buttons and
toolbars, oh my!
First let’s identify what these
things are:

I took an informal poll here in my
hallway, and found that some of my
coworkers think that customizing
the hotel room makes their trip more
enjoyable. I feel the same way about
customizing my Office products.

Go ahead: Be needy
So...what do you need? Maybe
you want really large, WIDE
drop-down lists that take up half
your screen. Or maybe you just
don’t feel fulfilled until every single
toolbar and toolbar button that’s
available to modern humanity is up
there, standing tall, and available to
you at all times.
Whatever your needs, Office is
ready for you to settle in. And the
easiest way for us to get started is

1. Menu bar The bar below the title bar that contains the names of
menus (such as File, Edit, View,
and Insert).
2. Menu command An instruction
that you want to give your Office
program (such as Save, Print, and
Open) that’s located on a menu.

3. Toolbar A bar (usually below the
menu bar) with buttons and options you use to carry out commands.
4. Button A graphic element that
performs a specific function. Similar to a menu command but in
graphical format. Several buttons
make up a toolbar.

Fly with me: Move a
toolbar
A docked toolbar is a toolbar
that’s attached to one edge of the
program window. You can tell it’s
docked if it has a move handle:

Got it? You are probably familiar
with these things but maybe you
didn’t know their names. Now that
we’re all acquainted, let’s get to
work.

Pick a toolbar...any toolbar
Different Office programs offer
different toolbars. For example,
Microsoft Excel offers the External
Data and Formula Auditing
toolbars, while Microsoft
FrontPage® wouldn’t know what to
do with such things. FrontPage has
the DHTML Effects and the
Navigation toolbars, while
Microsoft Visio® would scratch its
head and wonder, for all eternity,
what DHTML means.
You probably don’t want to see all
of the available toolbars all the time.
Sometimes you’ll want only the
Formatting toolbar up there, while at
other times you’ll just be interested in
the Formula or Drawing toolbars.
Guess what? You can pick which
ones you want to view.

To choose which toolbar(s) to
view
• On the View menu, point to
Toolbars and click the toolbar
you want to see.

(You need to do this each time you
want to add or remove a toolbar.)

To change a toolbar button
image and use a different Office
image
1. On the Tools menu, click Customize.
2. Click the Commands tab, and,
with the Customize dialog box
open, click the button on the
toolbar.
3. Click Modify Selection, point to
Change Button Image, and then
click an image.

Hide ScreenTips on buttons
1. Move handles on a docked toolbar

To move a docked toolbar
Drag the move handle to the new
location. (Try and remember where
you put it, OK?)

Never satisfied? Create a
customized toolbar
Maybe the toolbar choices Office
offers just don’t suit your needs.
Maybe you want a toolbar that is for
drawing, formatting, and creating
formulas. Now, instead of having to
have all three toolbars in view, create
one of your own.
1. On the Tools menu, click Customize.
2. Click the Toolbars tab.
3. Click New.
4. In the Toolbar name box, type the
name you want, and then click
OK.
5. Click the Commands tab.
6. Click a category in the Categories
box.
7. Drag the command you want from
the Commands box to the toolbar
you just created.
8. When you have added all the buttons and menus you want, click
Close.

Change a picture on a
button
What if you don’t like the current
button image? This one is for those of
you who travel with framed photos of
your loved ones.

You know that little note that pops
up when you rest your mouse pointer
on a button? That’s a ScreenTip. Like
it? Great; it’s on by default. Don’t
like it? Tell it as much and away it
goes.
1. On the Tools menu, click Customize.
2. Click the Options tab.
3. Clear the checkbox for Show
ScreenTips on toolbars.
Hint: If you totally dig ScreenTips
and want them to offer more, check
the box that says Show shortcut keys
in ScreenTips. It’s like having your
own personal hospitality specialist
giving you shortcuts to the best spots
in town.

Change the size of a toolbar
button or drop-down list
box
No more squinting!

To increase the size of a button
1. On the Tools menu, click Customize.
2. Click the Options tab.
3. Select the Large icons check box.

To change the width of
drop-down list boxes
1. On the Tools menu, click Customize.
2. With the Customize dialog box
open, click the list box you want
to change — for example, the
Font or Font Size box on the
Formatting toolbar.
3. Point to the left or right edge of
the box. When the pointer
changes to a double-headed arrow,
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drag the edge of the box to change
its width.

Add, change, or delete
sounds used with buttons or
menu commands
Some Office programs (Excel,
Microsoft Outlook®, Microsoft
PowerPoint®, and Microsoft Word)
have fun audio cues that play while
you work. Some of you like to hear
bells, while others prefer sirens.
Others like something more gentle,
like, say, the wind whispering
through the trees. And some of you
prefer silence.

To turn sound on or off
1. On the Tools menu, click Options, and then click the General
tab.
2. Select or clear the Provide feedback with sound check box.

To change sounds in Windows
XP
1. On the Start menu, click Control
Panel, and then double-click the
Sounds and Audio Devices icon.
2. Click the Sounds tab.
3. In the Program Events list, scroll
down to Microsoft Office, and select the sound you wish to turn on
or off — for example, Delete row.
I happen to like Explode. (Rest
your mouse pointer on the word
Explode, and when it changes
color, click it):
4.

5.

6.
7.

Explode
Note If Microsoft Office doesn’t
appear in the Program Events
list, install Office XP/2000
Add-in: Office Sounds.
If the sound you want to use is not
listed, click Browse to locate the
sound.
Adjust the volume by sliding the
Volume bar on the Volume tab.
Click OK.

Note To find out how to change
sounds in Microsoft Windows®
2000, Windows® NT, Windows®
ME, or Windows® 98, see Help for
those operating systems. (Between
you and me, it’s time to upgrade.)
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Restore original settings,
commands, or toolbars
Ack! Freaking out because what
you thought you wanted isn’t what
you wanted at all? Relax: You can
restore the default settings in each
individual program and try again.

To restore original settings for
buttons, commands, or toolbars
1. On the View menu, point to
Toolbars, and then click Customize.
2. Do one or more of the following:
• To restore original settings for a
menu:
1. With the Customize dialog box
open, right-click the menu you
want to restore, and then click Reset on the shortcut menu.
2. On the Customize dialog box,
click Close.
• To restore original buttons and
menus and a built-in toolbar:
1. Click the Toolbars tab.
2. In the Toolbars box, click the
name of the toolbar you want to
restore.
3. Click Reset.

Lost? Ask for directions —
in Help
I could give you a list of about
1,237 different online Help topics
that cover even the the most esoteric
aspect of each and every Office
program’s toolbar and button
customization procedures. Frankly,
I’d like to see you do something on
your own. All the various Office
programs access and deal with all
these features a little differently.
The best way to find out how
your program works is to access the
program’s Help by pressing my
favorite key: F1. The Help window
will pop up, and if you type toolbar
or button into the search box,
you’re bound to find what you need.

I hope you enjoyed your stay
with us. There is so much more to
explore in customization land — I
just can’t cover it all here. In a
future column I’ll cover other
features you can customize, such as
spelling and grammar, folder
locations, and templates.
“Style is knowing who you are,
what you want to say and not giving
a damn.” — Gore Vidal
__________

About the author
Annik Stahl, the Crabby Office
Lady columnist, uses Office all day
long. She gets her column ideas
from your wild suggestions and
demands, so if you’re feeling
demanding or just want to toss a
comment her way, leave Crabby
some feedback. If you have an
Office tip you’d like to submit, send
that to her personal mailbox at
crabby@microsoft.com. (While she
does read all of your e-mails, she
can’t offer personal assistance, so
don’t be offended by her curt
auto-reply...)

REVIEW

Plextor PX-716UF
DVD Dual Layer drive
By Terry Currier

P

lextor has always been known
for high quality products and the
PX-716UF drive is no different. The
Plextor PX-716 is a 16X DVD ±RW
burner available in both internal
(716A - ATAPI) and external. With

They also give you a plastic stand for
putting the drive on its side if you are
space limited. I tried it both ways and
had no problems.
Plextor includes a nice software
suite of Roxio Easy Media Creator™
7 for burning discs and organizing

three-dimensional tilt adjustment
for uneven disc surfaces.
• Buffer Underrun Proof Technology prevents buffer underrun errors
• Buffer Memory - 8MB

They also give you PlexTools
Professional. It allows you to control
the functions of the drive with a
Graphical User Interface (GUI.)
Modules of it are:

• SpeedRead allows control of
disc read speed

• PoweRead insures superior write
quality

• VariRec provides direct laser
•
•

an 8X DVD+R media, it can burn a
4.7GB DVD in less than six minutes.
By the way, at CES, Verbatim and
others announced they would soon
begin production on 16X DVD
media. The drive will also do
dual-layer DVD media allowing the
user to put up to four hours of
high-quality MPEG-2 video on a
single 8.5GB DVD disc. The
PX-716UF is an external drive,
connectivity is either USB 2.0 or
Firewire/IEEE 1394. Plextor includes
everything in the box, both types of
cables, utilities CD for the drive, a
blank DVD, even an emergency pin
to open the drive.
It comes in a sleek silver color
plastic casing. On the back panel is a
self-test switch, the IEEE
1394/Firewire and USB 2.0
connections, a switch to toggle
between the two connection types,
the power port and the power switch.

digital photos, music, and data. It also
includes VideoWave for easy editing
of your home movies. Plextor also
gives you the Roxio DVDMax Player
2.0 for watching DVD movies with
the drive. Also on the CD are USB
drivers for Window 98SE if needed,
Adobe Acrobat Reader, the user
guide and manual (they also give you
a printed copy) and a 30 day trial of
Retrospect for backing up your
computer. For Macintosh users, Toast
Lite version is included.
Integrated features for the drive
are:

• Intelligent Recording Technology supported for recording at
high-quality and optimum speed
• AUTOSTRATEGY® Writing
technology for unknown media
with uneven quality.
• Intelligent Tilt™ Precise laser
control via liquid crystal and

•
•

control
Silent Mode controls the sound
levels by varying the spin speed
SecuRec offers password protection for CD disc
Q-Check checks disc quality
GigaRec records up to 1GB on a
ordinary 700MB CD disc

When I read about the GigaRec I
just had to try that. They explain it
like this: “CD discs are manufactured
with special information about the
manufacturer, model name, disc
feature, and maximum write capacity
written to a narrow strip along the
inner margin of the disc. The Plextor
PX-716UF can ignore and even
overwrite this information, which
extends the disc capacity.” They go
on to say that the disc has to be
burned at a fixed speed of 4X or 8X,
and that the disc may not work in
other drives. With the GigaRec I put
93 minutes onto a 80 minute disc. I
was not too surprised when it played
in another computer’s drive. I was
really surprised, though, when it
actually played in the CD player in
my car.
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I hooked it up and tested it on
both of my computers. My main
computer (clone) is a 3.0GHz with
1GB of RAM, the eMachines is a
2.66GHz Intel Celeron with 768MB
RAM. Both of my computers have a
DVD read-only drive. My main
computer has a internal Mad Dog
dual layer 16X DVD ±RW drive.
The eMachines has a external (USB)
LITE-ON 8X DVD drive. For these
tests I used a DVD RW disc (okay
I’m cheap). Here are some of the
comparison test results:

• eMachines DVD drive to
LITE-ON disk copying took 47
minutes 39 seconds
• Same disc on eMachines DVD
drive to Plextor disk copying took
47 minutes 04 seconds

• eMachines copying 4.2GB of data
from computer to LITE-ON took
24 minutes 5 seconds
• eMachines copying 4.2GB of data
from computer to Plextor took 23
minutes 26 seconds

• Main computer DVD drive to Mad
Dog, disk copy took 1 hour 5 minutes 42 seconds
• Same disc on main computer DVD
drive to Plextor took 1 hour 2 minutes 21 seconds

To compare speeds of USB to
Firewire I did another DVD disk
copy.

• Copy DVD disc on main computer
to Plextor with USB 1 hour 3 minutes 8 seconds
• Copy same disc on main computer
to Plextor with Firewire 1 hour 2
minutes 31 seconds

To be accurate I defragged my
drive and rebooted the computer in
between each test. Helps to have
Executive Software Diskeeper for
the defragging. I also ran Nero
CD-DVD speed test on all of the
drives. To run these tests, I used a
Memorex 52X CD. It was most
interesting to see the results in the
amount of CPU power each needs. I
was surprised the external Plextor
used more, and was faster.
OS Support
Windows® 98SE/Me/2000/XP™
Mac OS 9.1 or above
One-year full warranty (parts and
labor)
Minimum Systems Requirements
• CPU: Pentium® 4 1.4GHZ (minimum)
• HDD 800 MB - 1 GB free space
for copying CD to CD image
• 10 GB-10 GB free space for DVD
authoring
• RAM 256 MB
• Monitor Display Resolution 1024
X 768 at 16-bit color
• Interface: Dual IEEE 1394 and
Hi-Speed USB
Plextor can be reached at
http://www.plextor.com

Summary
The drive is really
great—especially for the GigaRec.
The fact that it will do either USB or
Firewire is a real plus. The great
thing about external units are that
you don’t have to open up the
computer and figure out which
jumper pin to put on where. You just
plug it in and it works. The drives
run from $172-$224 on
http://www.Pricegrabber.com

WINNERS
Webpage
By Terry Currier, webmaster

I

thought I would let you know
of some of the additions made to
the WINNERS webpage. On the
Links page, I added some new
categories such as: Radio Shows
(computer) listings, both local and
throughout the USA; Shopping,
including Froogle, Price Grabber,
and Sales Circular that tell you
what’s on sale at the retail stores
this week; and for the travelers I
listed many of the favorites for
checking on hotel and airline
information. Check it out at
http://www.windowsusers.org/link
s.html
The web hosting software lists
where people go and what they
search for from Google and other
search engines. I noticed that
there have been a number of hits
looking for clip art. This is kind
of funny since they were all
looking at my review of Namo
web editor. In it I mentioned
there was a lot of clip art. So
since they kept coming I made
up a web page listing other web
sites with great clip art, mostly
free. You can see it at
http://www.windowsusers.org/cli
part.htm.
Lastly, when Dr. Gary Sexton
came, he recommended a number
of web sites for medical
information. I finally got around
to listing those and others I
discovered. Hope you are able to
find it of help at
http://www.windowsusers.org/me
dical-websites.html.
BTW, we are at an average of
320 hits a day, so hopefully
people are finding it of use.
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REVIEW

LucidLink from Interlink
By Terry Currier

I

f you want to find out how to
make your wireless network secure,
you could go to Google and put in
“instructions to secure wireless.” I
got 23,300,000 instants with web
sites that tell you how to set up your
wireless network. There are very
good sites with detailed instructions
on how to do it. In fact the very first
one is a Microsoft site telling how to
set up Wi-Fi Protected Access
(WPA) security.
Even if you have an Ethernet
network, everyone should change
their workgroup name. For security,
you should change it from the default
(MSHOME) and not make it too easy
for the hackers. To change the
workgroup name in Windows XP, go
to Control Panel and then System.
Click on the Computer Name tab and
then click Change. Under Member of
Workgroup type in a new name.
Following the advice of the web
sites will make your wireless
networks more secure. However,
there are more things you can do. In
an article on Zdnet
http://blogs.zdnet.com/Ou/index.php?p=43

George Ou wrote about The six
dumbest ways to secure a wireless
LAN.

• MAC filtering: This is like hand•
•

•
•

ing a security guard a pad of paper with a list of names.
SSID hiding: There is no such
thing as “SSID hiding”.
LEAP authentication: The use of
Cisco LEAP authentication continues to be the single biggest
mistake that corporations make.
Disable DHCP: This is more of
waste of time than it is a security
break.
Antenna placement: only put
their Access Points in the center

of their building and put them at
minimal power.
• Just use 802.11a or Bluetooth:

Dishonorable mention went to
WEP as only taking a few minutes to
break.
Again, using Google, you can find
web sites that actually list the latest
vulnerabilities. I found one that even
listed vulnerable programs names and
web sites. Want to see something
scary? Take a look at a war drive in
the Los Angeles area.

One who still needs that protection,
but does not know how to get an IP
address. In talking to the company,
they said their next version will come
with a IP finder program. It will
suggest an IP which you can just plug
in. They will also be putting in
something on the toolbar for you to
click on to check for updates.
It is very easy to install with
802.1X access points which are fully
compatible. You can check out which
those are at:

http://pasadena.net/apmap/losangeleslarge.gif

http://www.lucidlink.com/Tech_Support/Compatibility.asp

The red spots are open hot Wi-Fi.
The author noted that less than half
had even WEP enabled.

If not listed they give instructions
on how to set it up manually.

The use of a Wi-Fi Protected
Access(WPA) is much better, but not
perfect. It was reported in November
2004 that a WPA Cracker Tool was
developed. The data is retrieved via a
packet sniffer entered into the
program and using a dictionary word
based passphrases it runs the cracking
algorithms. The more random your
characters are for the WPA preshared
key, the safer it is to use. In simple
terms use letters and numbers, not
logical words.
The simplest answer of all is to use
LucidLink from Interlink. Two
reasons people do not set up
protection is because they don’t know
it is needed, and they can not figure
out how to do it.
Once installed on a Windows
2000, 2003 or XP computer acting as
a network server it is very simple to
use. The administrator has to set up
the access or router control from a
pull down list featuring a list of
compatible units.
The hardest part of the install was
putting in an IP address for the
D-Link Access Point. I knew how to
get one, but what about a beginner?

You will then need to install the
client part onto the wireless computer
you want to log onto the network
with. That computer when trying to
log onto the network is stopped from
fully getting in. They are given a
authorization code. Then the person
communicates to the administrator
the code and the user is authorized, or
denied entry. If a person leaves
employment or the laptop is stolen,
the administer can click
De-Authorize next to the user name
on the Management Console. It
reminded me of the electronic entry
doors you often seen in banks. They
can see who wants to get in, and if
the person is not suppose to get in,
they can not.
I was working with the server
version of LucidLink that is available
in 10, 25, 50, 100, and 250 user
versions starting at $449. The home
version for three users is/was $99.
They have decided to release the
home version out for free. Now there
is no excuse for not securing your
wireless network. I would not hesitate
to recommend this product. You may
not need the server version, but if you
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have a wireless network at home
you really should get the free
download.
Testing was done on a Linksys
router connected to a D-Link
DWL-2100 AP (Access Point.) I
used a D-Link, ActionTec, and
Buffalo PCMCIA wireless cards
(with two notebooks.) I also had a
wireless built in my HP notebook.
All of them could not get through
without authorization, but after
authorization no problem.
http://www.lucidlink.com

Requirements
• Windows 2000, 2003, or XP operating system
• 50MB of hard drive space
• Administration rights on the installed computer
• Every machine that you want to
connect to the wireless network
must be set up as a LucidLink Client. Those computers must have:
• 36 MB available hard disk space
• Windows 2000 or Windows XP
(Professional or Home) operating
system
• Wireless NIC that supports
802.1X/EAP

President’s Message

T

he word at Winners this month is
UPS. . . No, not the delivery service.
Do you have a UPS for your computer?
When was the last time you checked your
UPS unit? When did you last replace the
battery in your unit?
These are three important questions that
any serious computer user should be able
to answer. With all the uncertainties of
electrical supply to our homes, it’s a good
time to think about whether your UPS
(uninterruptible power supply) is functioning properly or not.
When is the last time you checked your
UPS to make sure it is operational? There
usually a button or switch you can push
that will determine the status of your system. It if sends out an audible alarm or the
red light is on, it may not be functioning
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The following hardware is compatible with LucidLink
Access Point / Router

Wireless NIC’s

3COM Office Connect 11abg
Allied Telesyn WA7500
Cisco Aironet 350
Cisco Aironet 1100
Cisco Aironet 1200
ColubrisCN320
ColubrisCN1250
D-Link DWL-2100 AP
D-Link DWL-2000 AP
D-Link AirPlusXtreme G Router
D-Link DWL-2200
D-Link DWL-2700
D-Link DWL-7100
Intellinet SuperG (522755)
Linksys WAP54G
Linksys WRT54G Router
Linksys WRT54GS Router
Netgear 802.11g Prosafe
Proxim AP600
Proxim AP4000
SMC 2552W-G
SMC 2555W-AG
SMC 2870W
Symbol Spectrum 24
Motorola WA840G
ZyXel ZyAirG-1000

3COM Office Connect 11g
3COM 3CRWE154A72
D-Link DWLG650
Intel Centrino
Linksys WPC54G V1.1, V1.2, V1.3
Linksys WP54GS
Motorola WN825G
Netgear WG511
Netgear WG511T
Orinoco Gold
Orinoco Silver
Proxim Orinoco 11 b/g Silver 8471-WD
SMC 2532 W-B
SMC 2835W
ZyXel ZyAir B101

properly. Check your user manual for details on your particular brand and model.

for home use, the only way to get a new
battery was through the manufacturer.
Many times, the batteries were special units
made specifically for the manufacturer and
unit model. They were expensive, sometimes exceeding the cost of a new UPS.

When is the last time you checked your
battery for the unit? The main function for
the battery is to provide power during an
electrical outage to keep you system running until the power returns or you’re able
to shut the system down automatically or
manually. Better quality systems also condition the AC power you receive to take
out spikes or add voltage in low power
situations.
How old is your UPS and have you ever
replaced the battery? If your unit more than
four years old, then the battery may need
replacement. Most batteries are the
old-fashioned lead-acid batteries, just as
the ones in your automobiles. They have a
finite life and need eventual replacement.
Now the big question is, where do I get
a new battery if my old one needs replacement? When UPS systems first came out

With the popularity of UPSs, many of
the batteries are now available at local battery shops. When mine bit the dust, I found
out the manufacturer wanted $45 plus shipping. I found a local shop that could get
one within 24 hours and the price was $28
total.
Remember, your computer and data are
valuable and need to be protected. Make
sure you have a UPS properly sized for
your system and capable of running for 20
to 30 minutes, plenty of time to protect
your system and allow a safe shutdown.

Steve

REVIEW

ADS Tech Instant Music
By Terry Currier

• Have a good needle. If you hear

T

a lot of scratching sounds and
the record looks good, get a new
needle.
• Clean the record. Don’t let the
dust pack-up onto the need and
spoil the recording.
• Have good speakers. I don’t care
how careful you are with the recording, if you only play them
through $5 speakers it will not
sound good. Get a set with a
subwoofer to control the quality
of the sound.

he ADS Instant Music is a
hardware/software setup that makes it
easy to import your old vinyl records
or cassette tapes into your computer.
It consists of a junction box for you
to connect your record or cassette
player to the computer. On the unit
are two RCA jack ports for audio in
and audio out. There is also a SPDIF
(Toslink) input and one for out.
Power to run it comes from the USB
connection. The setup includes a 6ft
USB cable, a 6ft RCA double jack
set, and a Y RCA jack for connection
to the stereo unit and the computer.
The cables make it easy to connect
the unit to the stereo through the
headphone jack (or speaker jacks if
you prefer). The unit then connects to
the sound card with RCA jacks or
with the USB connection.
With the unit, ADS includes Nero
for recording the music and editing it
to remove scratches and hiss sounds.
ADS tells you briefly how to get
Nero to do the recording. There are
other programs you can use to do the
recording including Roxio,
Polderbits, and Audiograbber. Nero
does do a fine job, and has an
excellent wave editor.
If you are expecting quality like
you get from a professionally
manufactured CD, forget about it.
They have thousands of equipment to
filter out the bad sounds, and still
maintain quality.
The best things you can do to get
good quality recording are:

• Have a good record - the better
quality record (no scratches) the
better recording. If you have a
section with a deep scratch skip
that part or it can ruin the needle.

The soundcard does not seem to
make much of a difference in the
recording part, but a good one will
sound better on the playing end.
Here are a few more things to keep
in mind.

• Get yourself some space. Each
minute of recording in wave format takes about 10MB of space.
Do record in wave format it is a
better quality than MP3. An LP
will usually take about 420MB.
My total of recordings is 42GB.
• You are going to be recording
and deleting large files (songs
you don’t really want.)
Defragging your computer will
help it run better.
• Time. We never really have
enough of it, but recording the
records and editing WILL take
time. Yes you can set it to record
and walk away. I did just that,
but in actual practice I found I
had to check each song to verify
sound quality, and if I really
wanted it. That may sound odd,
but how many albums do you
have that every song was great.

Connecting the ADS Instant Music
with the USB connector I noticed that
Nero puts it as recording from a
microphone in. Normally that would
make it a mono rather than stereo

recording, but the ADS Instant Music
handled it in stereo. So if you wanted
to you could do the recording onto a
laptop.
If you already have the Nero or
Roxio suite then you can do the
recording and editing through them.
You only have to purchase the
connecting cables. If you don’t this is
a good value to get everything
together.
I had not played my old vinyl
records in years. I put them to the
side as inconvenient. Now I really
enjoy listening to them on CD. Even
some of the songs that I thought I
may not want to record I find myself
singing along with—in the car with
the windows rolled up so no one else
will hear.
Prices from CompUSA website
ADS Tech Instant Music $50
Nero Suite $40
http://www.adstech.com/

Requirements
• An available USB port
• CD-ROM - for software installation
• CD burner - for making VCD’s
or burning video files to
CD-writable discs
For Windows PC:
• Minimum CPU - Intel Pentium 3
500 MHz or faster
• Windows 98SE, WinME,
Win2000, WinXP (Home or Professional),
• 256 MB of RAM
Macintosh:
• Apple G4
• MAC OaS 10.X
• An available USB port
• Garage Band or Sound Studio
2.1
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June 11 - 9 a.m. to 12 noon
Orange Coast College
Science Building #149
IOGEAR
We are pleased to have Keith Renty come and show the great
products from IOGEAR. They make a large variety of computer
peripherals products including Keyboard/Mouse combo,
computer mice. including RF wireless mouse, video extenders, splitters and switches, memory card readers, USB
flash drives, USB hubs, KVM switches, and external drive kits. WHEW!!
Keith always does a great job of showing us great products and keeping us up to date with the latest. Just so you
know, he will be presenting in the second half of the meeting.
The above part is appealing to the intelligential side. Now for the greedy part.
Keith will be bringing raffle prizes and, as I said, they have great products.
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